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WEBCT INTRODUCTION (BOOTCAMP) 
MANUAL 

Overview 
This workshop is intended to give you a brief overview of WebCT, and how you can 
begin to create entire courses or complement a classroom-based course.  

WebCT is a program that resides on a server (computer that supplies files or services), 
allowing you and your students to access it via a web browser, such as Internet Explorer 
or Netscape. It also allows you to make changes to your course from any web-accessible 
location.  

After this class you should be able post a syllabus, add a URL link, add a Content 
Module, participate in email, threaded discussions, add students, and upload important 
information about your course. 

After completing this module you will be able to: 

� Adjust Your Browser Settings 

� Create a New WebCT Course 

� Log into WebCT 

� Understand WebCT Elements 

� Manage Files 

� Add a Syllabus 

� Adding Students to Your Course   

� View the Course as a Student 

� Add Links to Your Homepage 

� Add files to the Content Module 

� Add a Course Banner 

� Use WebDAV Drag and Drop Capabilities 
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Adjusting Your Browser Settings 
Before you begin using WebCT you should check your recommended browser settings to 
make sure that they are compatible with the WebCT program. 

Browser Directions 

Netscape Navigator 4.7, 
6.2.1, 6.2.2, 6.2.3 and 7.0 
excluding 4.78 and 4.79 

1. From the Edit menu, click Preferences. 
2. In the Category section, click Advanced. 
3. Ensure that Enable Java, and Enable JavaScript are selected. 
4. Click OK. 

Internet Explorer 5.0, 5.5 
and 6.0, excluding IE 4.0 
and 5.5 Service Pack 1 
(SP1) 

1. From the Tools menu, click Internet Options. 
2. Click the Advanced Tab. 
3. Under Microsoft VM, ensure that Java console enabled and 

Java logging enabled are selected. 
4. Click OK. 
If you selected Java console enabled, restart your computer. 

AOL 7.0 and 8.0 – If you 
use AOL for Web access, 
you will need the AOL 
version 7.0 and 8.0, and 
Internet Explorer 5.0 
browser or higher. Do not 
use earlier versions of the 
AOL client with earlier 
versions of Internet 
Explorer, as you will have 
difficulty accessing many 
of the WebCT features 
Note: AOL 7.0 does not 
function with 
Chat/Whiteboard 

1. From the Settings menu, click Preferences. The Preferences 
screen appears. 

2. Click The Web. 
3. Click Set up now. The Internet Options screen appears. 
4. Click the Security tab. 
5. For the Web content zone, select the Internet. 
6. Click Custom Level. The Security Settings window appears. 
7. Scroll down to Microsoft VM, and under Java Permissions, 

select High Safety. 
8. Scroll down to Scripting and enable the following settings: 

• Active scripting 
• Allow paste operations via script 
• Scripting of Java applets 

9. Click OK. 

Note: In WebCT 4.0 you can check to make sure that your browser is compatible by 
logging into WebCT. On the myWebCT page click the Check Browser link at the top 
right-hand corner of the page. The browser check will determine if your browser version 
is compatible with WebCT. 
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Creating a New WebCT Course 
To create a new WebCT course, follow the steps below: 

1. Before you can access your online course you will need to fill out and submit an 
online form.  

2. Navigate to the New Account Request Form website 
http://www.colostate.edu/webct/New_Account.html. 

3. Fill out the course information, and click the Continue button at the bottom of the 
page. Once the form is submitted the class will be available within twenty-four hours. 

Logging into WebCT 
Once you have submitted an online form and received an e-mail confirmation that your 
course has been created, you can log into that course from the CSU WebCT web site 
(http://webct.colostate.edu). 

Note: Your User name and Password will be the same as your CSU eID (eIdentity is a 
unique identifier for each authorized user at Colorado State University.) 

 
To log into the CSU WebCT web site, do the following: 

1. Navigate to the http://webct.colostate.edu/ page. 

http://www.colostate.edu/webct/New_Account.html
http://webct.colostate.edu
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2. Click the LOG ONTO MYWEBCT button. The User Name and Password screen 
appears. 

3. Enter in your eID User Name and Password. The myWebCT page appears. 

Understanding WebCT Elements 
Now that you have a good understanding on how to add courses and adjust the browser 
settings, you can access the main introductory page, or myWebCT page.   

myWebCT 
The myWebCT page contains a list of courses, important bookmarks, announcements, 
and helpful links. You can navigate to your courses through this page or go helpful links 
in the banner to manage your courses more efficiently.  

 

The myWebCT banner lists the following links: 

� Bookmarks ⎯Lists important links to information and notable web sites. 

� Global Calendar⎯The global calendar provides you with centralized access to 
entries from your private myWebCT calendar, from the calendar for an individual 
course, and from the calendars for multiple courses. 

� Preferences⎯Changes the Accessibility Preferences and allows you to switch to a 
high-contrast color scheme. 

� WebDAV info—Drag and Drop information for WebCT files. 

� Course functions – Allows you to create a backup of your WebCT course. 

Homepage Screen Elements 
All courses you have requested or are a designer are listed after you click the desired 
course link. Below is a description of the elements in the WebCT course; Menu Bar, 
Navigation Bar, Breadcrumbs, and Content Area. 
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The Menu Bar contains links to myWebCT, Resume Course, Course Map, Check 
Browser, Logout, and Help. It also shows your current location and indicates whether 
you’re in View or Designer Options. Each of these items is described below: 

� MyWebCT⎯Contains links to all the courses that you are teaching or taking, along 
with announcements, bookmarks, and a link to WebCT’s e-Learning hub. 

� Resume Course⎯Allows students to resume their place in the Content Module 
(course content). 

� Course Map⎯Allows you and your students to see the course structure on one page. 
The course elements are links, enabling you to go directly to any place in the course. 

� Check Browser – WebCT Campus Edition automatically checks whether your 
browser is validated for use with WebCT in the login screen, in myWebCT, and in 
course Homepages.  

� Logout⎯Logs you out of WebCT. 

� Help⎯Links you to context-sensitive online help. 

The Navigation Bar on the left contains a Show/Hide Navigation toggle, a Control Panel, 
and a Course Menu section. Show/Hide Navigation toggle allows you to hide the 
Navigation Bar to expand the Content Area. 

� Control Panel⎯Provides central access to course creation and management 
functions. It is visible only to designers. 

� Course Menu⎯Provides access to course elements. It is visible to designers and 
students.  

� Content Area⎯is where the actual course material is displayed. 

� View⎯Allows you to see how the course will appear to a student. On some screens, 
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View only approximates what a student sees. To see the actual student view, log on to 
your course as a student. (See Viewing the Course as a Student) 

� Designer Options⎯Allows you to make modifications to tools, pages, or content. 

Managing Files 
The first step in adding information to your WebCT course is to add files to the Manage 
Files area which is the central storage area for all the files that make up your WebCT 
course. 

To manage files in your course, do the following: 

1. Click Control Panel button in the top left-hand area of the WebCT page. 

2. Select the Manage Files option under the Basic Control Panel. The Manage Files 
screen appears: 

 

As a designer you have the option to upload, move, and delete files. In addition, you 
can create new folders in WebCT to manage and move files.  

Uploading Files 
A WebCT course consists of HTML, text, and graphic files which are used by the various 
tools within WebCT. With that in mind, you can upload Microsoft Word, HTML, TXT, 
PDF, Power Point, or other file types that WebCT supports. 

To upload files, do the following: 

1. Under Actions, select Upload. The Upload File screen appears: 
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2. Click the Browse button to navigate to your local drive (your computer’s drive) and 

select the file you would like to upload.  

3. Select the Destination folder. 

4. Click Upload. 

Downloading Files 
If you would like to download files to save information to your local drive you can 
accomplish this by clicking the Download button on the right-hand menu. 

To download files, do the following: 

1. Select the file you want to download by check-marking the box next to the file. 

2. Click Download. The Download File screen appears: 

 
3. Save the file to your local or network drive. 

Note: You also have the option to edit HTML and TXT files, delete, copy, move and 
rename files in the Manage Files area. You can also upload a .zip file and unzip the 
file in the Manage Files are if you want to upload multiple files. 

Managing Folders 
You have the option to create folders. It is recommended that you do this in order to 
organize the files.  

To add folders, do the following: 

1. Under Actions > Options:Folders select the Create folder button. The Create 
Folder screen appears: 

http://www.ois.colostate.edu
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2. Type a name for the folder. 

3. Click the Create button. 

Adding a Syllabus 
Adding a syllabus to your course allows you to create a customized course outline. You 
can attach a file to the Syllabus tool or you can add custom sections which can be saved 
in TXT, or HTML file formats.  

Adding a Custom Syllabus 

As mentioned previously, you can upload a custom syllabus in many formats. To 
complete this task, follow the steps below: 

1. Click Control Panel button in the top left-hand area of the WebCT page. 

2. Under Control Panel navigation links Select Manage Files. 

3. Under Actions, select Upload. The Upload File screen appears: 

4. Click the Browse button to navigate to your local drive (your computer’s drive) and 
select the file you would like to upload.  

5. Select the folder you would like to copy the file too. 

6. Click Upload. 

Adding a File to the Syllabus Tool 
You can add different file types to the WebCT Syllabus tool; Word, PDF, and HTML are 
some of the most common.   

To add a file to the Syllabus, follow the steps below: 

1. Navigate to your course. 

2. Select the Syllabus link in the left navigation bar or on the homepage. 

Note: If you have not added the Syllabus tool to your WebCT course or do not see it 
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listed navigate to the Add Page or Tool option and follow the directions to add the 
Syllabus tool to your course. 

 
3. Under Actions, select Syllabus file. 

4. Click Browse. The Manage Files area appears. 

5. Select the file you wish to attach to the Syllabus. 

6. Click Add Selected. The File will be displayed in the Filename box 

 

7. Click Update. 

8. Select the View tab. The Syllabus file will be displayed in the WebCT Syllabus tool. 

Adding a Predefined Section 
To add a predefined section to your syllabus complete the following steps: 

1. Under Actions, select Syllabus tool. The Syllabus tool options will appear: 

http://www.ois.colostate.edu
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2. Click the Section you wish to make Active and select Options: Syllabus Tool > 

Edit. The Section you choose to add/edit appears. 

 

3. Fill out the appropriate information, and click Update.  

4. Click which sections you want to be Active by placing a check mark in the same row 
as the section and click the Update button. The sections that are marked as Active 
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will be displayed in the Syllabus tool 

Note: Notice that you can enter information in either Plain Text or HTML. If you select 
HTML you don’t have to include HTML tags when you select HTML. If no tags are 
entered, text will have a style sheet applied, which sets the font type and size. 

Adding Students to Your Course 
You can use the Manage Students tool in WebCT to add, view and delete students from 
your course. 

Adding One Student To Your Course 
You have the option to add a student to your course who is not registered for that 
particular course. This could be a student who is taking an incomplete or an assistant who 
is going to view the course as a student.  

To add one student to the course, do the following: 

1. Click Control Panel button in the top left-hand area of the WebCT page. 

2. On the Basic Control Panel screen click Manage Course. 

3. Under Manage Students click Add or Import Students. 

4. Under Import From Global Database choose the Add one student at a time to 
course: Enter the student’s WebCT ID and click Add.  

 
5. Enter the student’s WebCT ID or eIdenity. 

6. Click the Add button. The student’s record is added. 

Adding Multiple Students to Your Course 
You do not have to add your students to the course one at a time. You have the option 
add your entire roaster at once. 

To add multiple students, do the following: 

1. Click Control Panel button in the top left-hand area of the WebCT page. 

2. On the Basic Control Panel screen click Manage Course. 
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3. Under Manage Students click Add or Import Students. 

4. Under Import From Global Database choose Add multiple students from a 
registered course: Enter the registered course name and click Select. 

 
5. Enter the six-digit course section ID of your course (you can find this number in the 

CSU Course Catalog). 

6. Click the Select button. The student’s records will be displayed. Click the Select 
button again to upload them into the Manage Student gradebook. 

Synchronizing Your WebCT Course 
During the first couple months of school, students will be adding and dropping courses. 
Keeping this in mind, your class roster will probably change.  

To update you course, do the following: 

1. Click Control Panel button in the top left-hand area of the WebCT page. 

2. On the Basic Control Panel screen click Manage Course. 

3. Under Manage Students click Add or Import Students. 

4. Under Import From Global Database select Update your existing student list: Enter 
the registered course name and click Synchronize. 

http://www.ois.colostate.edu
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5. Enter the six-digit course section ID of your course. 

6. Click the Synchronize button. The update records screen appears: 

 

If you already have students in your course, WebCT will present three preview tables. 
If you have students in your course that do not match the six-digit number, a Delete 
Records table will appear in addition to the Add and Update Records. If you choose 
not to delete students from the course, click the Select none option at the top of the 
Delete Records table. You can also do the same for the Add and Update tables.  

Important: It is up to the instructor to preview the information and determine how to 
update the WebCT grade book by choosing the Select All or Select none option. 
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7. Click Synchronize when you are satisfied with the preview. 

Viewing the Course as Student 
WebCT allows you the designer to view the course as a student. When you are given 
designer access to WebCT the program automatically creates a student login by adding a 
“ _s” to your eID. This is important to remember when setting up your course. 

To setup the student view, do the following: 

1. Click Control Panel button in the top left-hand area of the WebCT page. 

2. On the Basic Control Panel screen click Manage Course. 

3. Under Manage Students click Add or Import Students. 

4. Under Import From Global Database choose the Add one student at a time to 
course: Enter the student’s WebCT ID and click Add.  

5. Enter your student eID. (If your eID is cnimmo then your student eID will be 
cnimmo_s). Your password will stay the same. 

 

6. Click Add. Your student ID will be added to the course. You can now open a new 
browser window and log into WebCT with your student eID and password. 
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Adding Links to your Homepage 
You may want to add links to certain information that you have uploaded into your 
course. The two most common ways is to add a new link to your Homepage/Organizer 
page or to the Content Module tool. Follow the steps below to add links to your 
Homepage or Content Module. 

Adding a URL Link to you Homepage/Organizer Page 
Within your course you may want to add links to outside material. For example, a 
biology instructor may want to add links to scientific information that he/she thinks might 
be helpful for the student’s research material.   

To add links to an Organizer or Homepage, do the following: 

1. Click Control Panel button in the top left-hand area of the WebCT page. 

2. On the Basic Control Panel screen click Add Page or Tool. 

3. Under Pages click the URL link. The Add URL page will appear: 

 

4. Enter a title for the page. 

5. Enter the information for the URL. 

6. Choose to open this page in a new browser window or the same frame. 

7. You can decide where to display this link either on the Navigation Bar or the 
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Organizer Page. 

8. Choose a default icon or Browse to add a custom icon. 

9. Click the Add button. 

Adding a Link to an Uploaded File 
You may want to add links to information that you have uploaded into your Manage Files 
area. For example, you might want to link to an important article that is in PDF (Portable 
Document Format) so that you students can view the information.   

To add links to an Organizer or Homepage, do the following: 

1. Click Control Panel button in the top left-hand area of the WebCT page. 

2. On the Basic Control Panel screen click Add Page or Tool. 

3. Under Pages click the Single Page link. The Add Single Page will appear: 

 

4. Enter a title for the page. 

5. Click the Browse button to navigate to the Manage Files area.  

6. Select the file you want to link to the Homepage/Organizer page. 

7. Click the Add Selected button. The file should be displayed in the Page filename: 
box. 

8. Choose to open this page in a new browser window or the same frame. 

http://www.ois.colostate.edu
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9. You can decide where to display this link either on the Navigation Bar or the 
Organizer Page. 

10. Choose a default icon or Browse to add a custom icon. 

11. Click the Add button. 

Adding a Link to the Content Module 
The Content Module in WebCT is a functional tool. You have the option too add various 
types of files to the Content Module in a Table of Contents format. This can be very 
useful if you need to upload multiple files for you students to access. If you have not 
added the Content Module tool to your course, navigate to the Add Page or Tool link on 
the left navigation bar and click Course Content Tools > Content Module.  

To add files to the Content Module, follow the steps below: 

1. Click the Content Module icon. 

2. Select the Designer Option tab at the top of the WebCT screen. The Designer Options 
are displayed on the right side of the screen. 

http://www.ois.colostate.edu
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As mentioned previously, the Content Module is organized to display files in a Table 
of Content format. With this in mind, you have the option to add a heading, indent 
information and generally organize files in this format. 

Adding a Heading 
To add a heading to your list of information, follow the steps below: 

1. Click the Add heading radio button. The Add heading screen appears: 

 

2. Enter a title. 

3. Click Add. 
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Adding a File 
1. To add a file to the Content Module, follow the steps below: 

2. Click the Add files radio button. The add files screen appears: 

 

You have the option to select the Show only HTML files in the My-Files folder in 
Manage Files. By selecting this option, only HTML files will be displayed in the 
Filenames box. If you choose to select the Show all files in the My-Files folders in 
Manage Files a list of files in the Manage Files are will be displayed.  

Not all files in the Manage Files area will be displayed in the Filename box, 
especially files contained in folders. It will be important to click the Browse button to 
navigate to the Manage Files to select the particular file you would like to add to the 
Content Module especially, if you do not see them displayed in the Filename box. 

Note: You have the option to upload multiple files into the Content Module. 

3. Click the Browse button if you do not see the file you wish to choose to add to the 
Content Module. 

4. Select the file from the Manage Files area. 

5. Click Add Selected. The file will be displayed in the Filename box. 

6. Highlight the file in the Filename box. 

7. Click Add. The file is added to the Content Module. 
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Creating and Adding an HTML File 
To create and add an HTML file to the Content Module, follow the steps below: 

1. Select Create and edit HTML file. The Create and add HTML screen appears: 

 

2. Enter a Filename. 

3. Select the Destination folder to save the HTML file. 

4. Place your HTML content into the File Content box. 

Note: You have the option of using the HTML editor which provides word-
processor-like features that display text and graphics and will help you format your 
HTML content. 

5. Click Add. The file is displayed in the Content Module. 

Editing Titles 
You have the option to rename the title of the file you added to the Content Module.  

To edit titles follow the steps below: 

1. Click the radio button next to the file you want to change and select the Edit titles 
options from the Edit Table of Contents menu. The Edit Content Page Titles appears: 
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2. Edit the title and click the Update button.  

Indenting Files 
To indent files, follow the steps below: 

1. Click the radio button next to the file you would like to indent. 

2. Select Indent item option from the Organize option and click Go. You also have the 
option to indent the item less or more if you choose. 

 
You also have the option to the move files up and down the Table of Content list. This 
process can be done by selecting the radio button next to the Move item up and down 
option. 
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Adding a Course Banner 
In your course you might want to create a banner that would give some information about 
the course and would be a visual notification to the student that he/she is on the 
homepage. 

To add a banner to your course, do the following: 

1. Navigate to the Homepage of your course. 

2. Select the Designer View tab. 

3. On the right-hand side of the page are the Designer Options.  

4. Under Customize, select Modify/Add banner image. 

5. Click Go. The Modify/Add Banner Image for Page appears: 

 

6. To select a graphic for the banner select the Browse button and navigate to the 
Manage Files area. 

7. Select your banner graphic (remember you will need to upload the graphic before you 
can choose it in the Manage File area). 

8. Enter text in the Text box if you wish to add a title to the banner. 

9. Select the banner alignment. 

10. Click the Update button. 
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Using WebDAV Drag and Drop Capabilities 
WebCT 4.0 supports a new drag and drop file transfer tool called Web-based Distributed 
Authoring and Versioning or WebDAV.   

WebDAV is easy to use and includes the following capabilities: 

� Compatible with Macintosh and PC 

� Has a quick and easy setup 

� Users have the ability to drag-and-drop folders and files to their WebCT course from 
their computer’s file manager 

The setup for WebDAV involves using Web Folders in Windows 98, My Network Places 
in Windows 2000/ME/XP, or the free Goliath WebDAV client for Macintosh computers 
http://www.webdav.org/goliath/. 

A folder must be created for each course the designer will want to access. If you have 
three different WebCT courses, you will need to set up three separate Web Folders in 
your computers manage files area so that you can access the files separately in each 
course. 

System Requirements 
WebDAV is compatible with the following browsers: 

� IE 5 or above 

Note: WebDAV does not support Netscape. 

WebDAV is compatible with the following Operating Systems: 

� Windows 95/98/NT/2000/ME/XP 

� MacOS 8.1 or higher (users need to install additional software to use WebDAV. 
Goliath is available from http://www.webdav.org/goliath/). 

Known Problems with WebDAV 
If you choose to setup the WebDAV program on a Windows 2000 or XP operating 
system you may experience a recursive folder problem and may be asked to login to the 
server every time you select a subfolder.  This will be evident when you try to select a 
single folder and there are endless subfolders displayed under the main folder. To remedy 
this problem, you will need to delete the My Network Places connection you created and 
create it again. To fix this problem, create the link again and remove the (:443) port 
number from the URL that references the server. If the request for a login appears when 
selecting a subfolder, select cancel. You do not have to enter a login at this screen.  

http://www.webdav.org/goliath
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Setting Up WebDAV on a PC 
Windows 2000/ME/XP allows you to setup a new Network Place that is used by 
WebDAV to connect to the WebCT server.  

Note: Each WebCT course must have a different link to the Manage Files area. 

To setup WebDAV on a Windows 2000/ME/XP operating system do the following: 

1. Navigate to your WebCT course. 

2. Select the WebDAV Info link from the top of your myWebCT page. The WebDAV 
information appears: 

 

3. Copy the WebDAV URL course files link. 

4. Navigate to your desktop or Windows Explorer.  

5. Click on the My Network Places icon. 

 
6. Select the Add Network Places icon. 

 

7. In the Type the location of the Network Places box, paste the WebDAV URL. 
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8. Click the Next button. 

9. You will be asked to login with your eIdentity and ePassword. 

 

10. Click OK. The Completing the Add Network Place Wizard box will appear. 

11. Enter a name for your new Network Place. 

 
12. Click Finish. 

Navigate to your computer’s manage files area. You will now have a new Network 
Place displayed under your My Network Places. You will be asked to login when you 
access your course files from this link. 
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Setting Up WebDAV for Windows 98 
Users of Windows 98 will have the same setup procedures as Windows 2000 except the 
Network Places will be titled Web Folders in 98. 

Setting Up WebDAV for Macintosh Systems 
To implement WebDAV on a Macintosh system you will install a program from 
WebDAV called Goliath. There are two versions of this program: 

� Classic MacOS (The Classic MacOS application requires PowerPC based on 
Macintosh running MacOS 8.1 or higher). Information on this program can be found 
at: http://www.webdav.org/goliath/installs/Goliath_1_0_Installer.hqx. 

� Disk Copy archive for Mac OS X (This system requires MacOS X version 10.0.4 or 
greater) Information on this program can be found at: 
http://www.webdav.org/goliath/installs/Goliath1_0.dmg.gz.  

Note: A detailed help package for Goliath can be found at 
http://www.webdav.org/goliath/help0.9. 

Important: Once the Network Place or Webfolders have been set up on your computer, 
you can use WebDAV with any Microsoft Office programs. Be aware, that if you are 
using the WebDAV program to modify files you are modifying files on the server 
and do not have a backup on your computer. 

http://www.webdav.org/goliath/installs/Goliath_1_0_Installer.hqx
http://www.webdav.org/goliath/installs/Goliath_1_0.dmg.gz
http://www.webdav.org/goliath/help0.9
http://www.ois.colostate.edu
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Using WebDAV with Macromedia Dreamweaver 
You can also use Dreamweaver to connect to WebDAV (Web-based Distributed 
Authoring and Versioning) protocol if you have a system that supports that protocol. Two 
examples of WebDAV servers currently available are Microsoft Internet Information 
Server (IIS) and Apache Web Server. 

To connect to WebDAV within Dreamweaver, do the following: 

1. Open Macromedia Dreamweaver. 

2. Click Site > Define Sites. 

3. In the Site Definition dialog box, select Edit. 

4. In the Category box, select Remote Info. 

5. In the Access pop-up menu, choose WebDAV. 

6. Click Settings. The WebDAV Connection dialog box appears. 

 
7. In the URL file, enter the complete URL to the directory listed in the WebDAV Info 

page. This URL includes the protocol, port and course server name. 

8. Enter your eIdentity and ePassword in the Username and Password fields. This 
information is for server authentication and not related to Dreamweaver.  

Note: If you do not remember your eIdentity and ePassword contact ACNS at 491-7653. 

9. In the Email field, enter your e-mail address. This is required and is used to identity 
ownership on the WebDAV server and appears in the Site window for contact 
purposes. 

10. Select the Save Password to store your password once you have exited 
Dreamweaver. When you start a new session the password will be saved. 

11. Click OK. 

12. Choose Site > Connect or click the Connect button on the site window tool bar to 
connect too the remote site. To disconnect, choose Site > Disconnect or select the 
Disconnect button. 
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Once you are connected to WebDAV in Dreamweaver you can use the file sharing 
features to transfer and modify files in Dreamweaver and your WebCT course. You 
can change you connection information by following the steps above and entering 
new information into the WebDAV connection dialog box. 

Information 
For more information about Workshops or WebCT Bootcamp contact Christina Nimmo, 
Instructional Services #491-0905 or email cnimmo@lamar.colostate.edu. 
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